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About this document
Scope and purpose

This user guide helps users operate the KIT_T2G_C-2D-6M_LITE (TRAVEO™ T2G Cluster 6M Lite), a cost-effective
evaluation kit. The kit is built around the CYT4DN device from the TRAVEO™ Cluster 2D family of
microcontrollers and includes an HDMI interface and onboard EZ-USB™ FX3.
The document outlines the features and functions of the TRAVEO™ T2G Cluster 6M Lite Kit, offering
comprehensive information on available interfaces and the usage of all hardware interfaces.
Intended audience

This document is intended for software and hardware engineers who are evaluating the TRAVEO™ T2G Cluster
2D family CYT4DN device.
Evaluation board

This board is to be used during the design-in process for software evaluation.

Note: PCB and auxiliary circuits are NOT optimized for final customer design.
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Important notice
“Evaluation Boards and Reference Boards” shall mean products embedded on a printed circuit board
(PCB) for demonstration and/or evaluation purposes, which include, without limitation, demonstration,
reference and evaluation boards, kits and design (collectively referred to as “Reference Board”).
Environmental conditions have been considered in the design of the Evaluation Boards and Reference
Boards provided by Infineon Technologies. The design of the Evaluation Boards and Reference Boards has
been tested by Infineon Technologies only as described in this document. The design is not qualified in
terms of safety requirements, manufacturing and operation over the entire operating temperature range
or lifetime.
The Evaluation Boards and Reference Boards provided by Infineon Technologies are subject to functional
testing only under typical load conditions. Evaluation Boards and Reference Boards are not subject to the
same procedures as regular products regarding returned material analysis (RMA), process change
notification (PCN) and product discontinuation (PD).
Evaluation Boards and Reference Boards are not commercialized products, and are solely intended for
evaluation and testing purposes. In particular, they shall not be used for reliability testing or production.
The Evaluation Boards and Reference Boards may therefore not comply with CE or similar standards
(including but not limited to the EMC Directive 2004/EC/108 and the EMC Act) and may not fulfill other
requirements of the country in which they are operated by the customer. The customer shall ensure that
all Evaluation Boards and Reference Boards will be handled in a way which is compliant with the relevant
requirements and standards of the country in which they are operated.
The Evaluation Boards and Reference Boards as well as the information provided in this document are
addressed only to qualified and skilled technical staff, for laboratory usage, and shall be used and
managed according to the terms and conditions set forth in this document and in other related
documentation supplied with the respective Evaluation Board or Reference Board.
It is the responsibility of the customer’s technical departments to evaluate the suitability of the
Evaluation Boards and Reference Boards for the intended application, and to evaluate the completeness
and correctness of the information provided in this document with respect to such application.
The customer is obliged to ensure that the use of the Evaluation Boards and Reference Boards does not
cause any harm to persons or third party property.
The Evaluation Boards and Reference Boards and any information in this document is provided "as is"
and Infineon Technologies disclaims any warranties, express or implied, including but not limited to
warranties of non-infringement of third party rights and implied warranties of fitness for any purpose, or
for merchantability.
Infineon Technologies shall not be responsible for any damages resulting from the use of the Evaluation
Boards and Reference Boards and/or from any information provided in this document. The customer is
obliged to defend, indemnify and hold Infineon Technologies harmless from and against any claims or
damages arising out of or resulting from any use thereof.
Infineon Technologies reserves the right to modify this document and/or any information provided
herein at any time without further notice.
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Safety precautions

Note: Please note the following warnings regarding the hazards associated with development systems.

Table 1 Safety precautions

Warning: The DC link potential of this board is up to 1000 VDC. When measuring voltage
waveforms by oscilloscope, high voltage differential probes must be used. Failure to do so
may result in personal injury or death.

Warning: The evaluation or reference board contains DC bus capacitors which take time to
discharge after removal of the main supply. Before working on the drive system, wait five
minutes for capacitors to discharge to safe voltage levels. Failure to do so may result in
personal injury or death. Darkened display LEDs are not an indication that capacitors have
discharged to safe voltage levels.

Warning: The evaluation or reference board is connected to the grid input during testing.
Hence, high-voltage differential probes must be used when measuring voltage waveforms by
oscilloscope. Failure to do so may result in personal injury or death. Darkened display LEDs
are not an indication that capacitors have discharged to safe voltage levels.

Warning: Remove or disconnect power from the drive before you disconnect or reconnect
wires or perform maintenance work. Wait five minutes after removing power to discharge the
bus capacitors. Do not attempt to service the drive until the bus capacitors have discharged to
zero. Failure to do so may result in personal injury or death.

Caution: The heat sink and device surfaces of the evaluation or reference board may become
hot during testing. Hence, necessary precautions are required while handling the board.
Failure to comply may cause injury.

Caution: The evaluation or reference board contains parts and assemblies sensitive to
electrostatic discharge (ESD). Electrostatic control precautions are required when installing,
testing, servicing or repairing the assembly. Component damage may result if ESD control
procedures are not followed. If you are not familiar with electrostatic control procedures, refer
to the applicable ESD protection handbooks and guidelines.

Caution: A drive that is incorrectly applied or installed can lead to component damage or
reduction in product lifetime. Wiring or application errors such as under sizing the motor,
supplying an incorrect or inadequate AC supply, or excessive ambient temperatures may
result in system malfunction.

Caution: The evaluation or reference board is shipped with packing materials that need to be
removed prior to installation. Failure to remove all packing materials that are unnecessary for
system installation may result in overheating or abnormal operating conditions.
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1 Getting started
This section provides an overview of the TRAVEO™ T2G Cluster 6M Lite Kit and provides step-by-step
instructions on setting up and powering on the kit. It also includes guidance on running the preprogrammed
firmware and configuring the default jumpers for a seamless experience.

1.1 Kit overview
This section offers a brief introduction to the TRAVEO™ T2G Cluster 6M Lite Kit and outlines the various
interfaces and peripherals included in the kit.

1.1.1 Introduction
The TRAVEO™ T2G Cluster 6M Lite Kit belongs to the TRAVEO™ Cluster 2D graphics family, featuring the CYT4DN
device as the MCU, an HDMI interface, and an onboard EZ-USB™ FX3 with a USB Type-C connector for streaming
RGB data packets to a PC screen. This kit is primarily designed to evaluate the functions and features of the
CYT4DN series microcontroller. The CYT4DN MCU includes two Arm® Cortex®-M7 CPUs for primary processing
and an Arm® Cortex®-M0+ CPU for peripheral processing.
The TRAVEO™ T2G Cluster 6M Lite Kit includes a TRAVEO™ T2G CYT4DN MCU, an HDMI interface for high-
resolution FPD-LINK video output, an EZ-USB™ FX3, external memories (SEMPER™ flash and HYPERRAM™), and
an onboard Ethernet PHY. Additionally, the kit features an onboard programmer/debugger (KitProg3), three
user LEDs, one potentiometer, two user push buttons, a MIPI-CSI2 connector, and two Type-C connectors.

1.1.2 Features
• The main features of the TRAVEO™ T2G Cluster 6M Lite Kit are as follows:
• TRAVEO™ T2G CYT4DN device (MCU)
• EZ-USB™ FX3 device
• PSOC™ 5LP (KitProg3) for programming and debugging
• Arm® Standard 20-pin JTAG header for programming and debugging
• Crystal oscillators:

- 16 MHz external crystal oscillator (ECO)
- 32.768 kHz watch crystal oscillator (WCO)

• Serial Memory Interface (SMIF):
- SEMPER™ NOR Flash (S28HS)
- HYPERRAM™ (S27KS)

• General-purpose I/O headers:
- mikroBUS header
- Arduino-compatible header (also compatible with CY8CKIT for CAN and LIN)
- Raspberry Pi-compatible I/O header (also compatible with Audio HAT for Audio Codec)
- Shield2Go

• HDMI interface for FPDLINK/Dual-FPDLINK output
• MIPI-CSI2 camera connector
• Onboard Gigabit Ethernet PHY
• Human Interface Devices (HID):

- User LEDs
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- Push button
- Potentiometer

• 2 x USB Type-C connectors:
- For FX3 output streaming and powering the kit
- For KitProg3 USB-UART bridge and powering the kit

Figure 1 shows the block diagram of the TRAVEO™ T2G Cluster 6M Lite Kit.

Figure 1 Block diagram of TRAVEO™ T2G Cluster 6M Lite Kit

Note: The block diagram includes only the major interfaces. Additional blocks may exist between the
CYT4DN device and the peripheral component block.

1.1.3 Peripheral details
This section provides an overview of the interfaces and peripherals available in the TRAVEO™ T2G Cluster 6M
Lite Kit.
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Table 2 shows the peripherals markup, reference designator and details about them, and their respective
locations highlighted in Figure 2.

Figure 2 Peripherals and interfaces in the TRAVEO™ T2G Cluster 6M Lite Kit

Table 2 Peripheral details

Sl no. Reference designator Description

1 X400 The USB Type-C connector is used to program and debug the
onboard PSOC™ 5LP (KitProg3) and to power up the kit.

2 X500 The USB Type-C connector is used for streaming TTL-RGB
display output to a PC.

3 U500 The EZ-USB™ FX3 is a peripheral controller that converts RGB
graphics output data packets to USB data packets.

4 U601 A 64 Mb HYPERRAM™ is connected to the SMIF-1 interface.

5 U600 A 512 Mb SEMPER™ flash is connected to the SMIF-0 interface.

6 U200 TRAVEO™ T2G CYT4DN microcontroller

7 X1000 Onboard Gigabit Ethernet PHY

8 X701 MIPI CSI-2 interface that supports MIPI CSI-2 camera module.

9 Y301 16 MHz external crystal oscillator
(table continues...)
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Table 2 (continued) Peripheral details

Sl no. Reference designator Description

10 Y300 32.768 kHz watch crystal oscillator

11 X700 HDMI interface for display support

12 X302 Arm® Standard-20 pin JTAG connector for programming and
debugging the kit.

13 X802 10-pin Arduino shields-compatible I/O header

X806 8-pin Arduino shields-compatible I/O header

14 S800 Shield2Go1 header footprint

15 S801 Shield2Go2 header footprint

16 X803 8-pin Arduino shields-compatible I/O header

X805 9-pin Arduino shields-compatible I/O header

17 X800 40-pin Raspberry Pi shields-compatible I/O header

18 S200 TRAVEO™ T2G CYT4DN MCU device reset button

19 X813 8-pin mikroBUS shields-compatible I/O header

20 S900 User push button 1 for human interface

S901 User push button 2 for human interface

21 D900 User LED1 for human interface

D901 User LED2 for human interface

D902 User LED3 for human interface

22 X812 8-pin mikroBUS shields-compatible I/O header

23 R904 Resistor-based rotary potentiometer

24 D104 3.3 V power monitor LED

D102 1.1 V power monitor LED

D103 1.2 V power monitor LED

25 S500 EZ-USB™ FX3 reset button

26 X502 EZ-USB™ FX3 bootloader jumper

27 S400 KitProg3 mode select push button

28 U400 PSOC™ 5LP (KitProg3) as onboard programmer and debugger

1.2 Kit contents
This section provides a detailed list of the components included in the kit.

Table 3 Kit contents

Quantity Description Remarks

1 KIT_T2G_C-2D-6M_LITE Rev-02 TRAVEO™ T2G Cluster 6M Lite Kit
(table continues...)
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Table 3 (continued) Kit contents

Quantity Description Remarks

1 USB Type-C cable For powering up the board and streaming EZ-USB™

FX3 data output.

1 HDMI cable For displaying graphics output

Note: For streaming FX3 graphics RGB packets via the Type-C cable, ensure that your PC has a USB 3.0 port.

Figure 3 Kit contents of TRAVEO™ T2G Cluster 6M Lite Kit

1.3 Initial jumper configuration
This section provides the default jumper configuration for each module. The default interface selection is
mentioned in Table 4. The jumper configuration ensures the generation of all power supplies from the
regulators and safely distributes them to power up the lite kit.

Table 4 Jumper configuration

Jumper Default Position Function

X101 Short 3.3 V PMIC

X102 Short 1.1 V PMIC

X403 Open KitProg3 does not reset

X502 Open FX3 will not be in bootloader mode
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1.4 Powering up the lite kit
This section provides step-by-step guidance on how to power up the TRAVEO™ T2G Cluster 6M Lite Kit using a
USB Type-C connection (KitProg3 also gets powered up here).
USB Type-C:
1. Connect the USB Type-C cable between the USB Type-C connector (X400) and the PC to power up the kit
2. Observe that the power LEDs (D104, D102, and D103) start glowing green
3. Additionally, observe that the VBUS LED (D400) starts glowing green
Figure 4 shows the connection of the USB Type-C cable.

Figure 4 Connecting the USB Type-C cable between the X400 connector and the USB port of a
PC

Note: The PSOC™ 5LP (KitProg3) also gets powered up. To verify if the PSOC™ 5LP ( KitProg3) is powered up,
check the KitProg3 mode status LED (D401). If it is glowing, then KitProg3 is powered up.

1.5 Preprogrammed firmware
The TRAVEO™ T2G Cluster 6M Lite Kit undergoes thorough testing to ensure the proper functioning of all
onboard peripherals, with the test report preloaded into the kit. Once the manufacturing test process is
successfully completed, the kit is shipped with preloaded software, a preloaded test report, and the FX3 test
pattern firmware.
To check the test report and run the preprogrammed firmware after powering up the kit, follow these steps:
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1. Power up the kit
2. Follow the procedure outlined below to check the test report and run the preprogrammed firmware

1.5.1 Board test report
To view the test report on your serial terminal window:
1. Connect the kit to your PC using the USB Type-C cable (X400)
2. Open Tera Term (or any serial terminal software) on your PC

Figure 5 Opening a serial terminal on the PC
3. Select the connection type as Serial and then, in the Port option, choose the port labeled KitProg3

USB-UART
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Figure 6 Selecting KitProg3 USB-UART port
4. Go to Setup > Serial port > Speed, select 115200 and press the New setting button

Figure 7 Selecting baud-rate of UART in terminal
5. Press the reset button S200 on the kit. The message logs (test results of peripherals) will be printed in

the terminal, as shown in Figure 8
6. Observe that the user LED (D901) in the kit will start blinking

TRAVEO™ T2G Cluster 6M Lite Kit user guide
KIT_T2G_C-2D-6M_LITE
1  Getting started

User guide 13 002-39885 Rev. *A
2025-02-06



Figure 8 Test log printed on the serial terminal window

1.5.2 FX3 firmware
To see the test image on your PC via EZ-USB™ FX3, follow the steps mentioned below:
1. Ensure that the jumper X502 (highlighted in the yellow box in Figure 9) is not shorted. If it is shorted,

remove the jumper
2. Disconnect and reconnect the power supply (USB Type-C, X400)

Figure 9 Checking FX3 bootloader jumper on the kit

TRAVEO™ T2G Cluster 6M Lite Kit user guide
KIT_T2G_C-2D-6M_LITE
1  Getting started

User guide 14 002-39885 Rev. *A
2025-02-06



3. Next, connect the Type-C cable (included in the kit) between jumper X500 and the USB 3.0 Type-C port
on your laptop or PC (FX3 supports only USB 3.0 ports)

Figure 10 Connecting the Type-C between X500 and the laptop's USB 3.0 port
4. Open the VLC media player and navigate to Media > Open Capture Device

Note: Alternatively, you can run this firmware with the provided Python script. Refer to the Python
script for streaming with FX3 section to run the Python script.
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Figure 11 VLC media player window
5. On the Open Media window, in the Capture Device tab, do the following:

a. In the Capture mode list, select DirectShow
b. In the Device Selection section, in the Video device name drop-down, select FX3
c. In the Audio device name list, select Default
d. In the Options section, in the Video size field, enter 800×480
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Figure 12 FX3 settings in VLC media player
6. Click the Play button and observe the test pattern IRIS in the VLC media player window

Figure 13 IRIS pattern image display on screen via FX3
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2 Programming the kit
This section details the available programming interfaces in the kit and guides you on how to program and
debug the kit using these interfaces and tools. The kit supports programming and debugging with third-party
software and hardware such as:
• IAR-EWARM (Embedded Workbench for Arm®) software and i-Jet debugger (requires ADA-MIPI20-TI14

adapter)
• Green Hills System (Multi IDE software and GHS probe debugger)

Figure 14 JTAG to 20-pin Arm® converter

2.1 Programming interfaces
This section details the various programming interfaces available in the TRAVEO™ T2G Cluster 6M Lite Kit. The
kit includes two programming interfaces:
• KitProg3 (onboard programmer/debugger)
• Arm® standard 20-pin JTAG connector
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Figure 15 Various programming interfaces available in the kit

2.2 Blink an LED
This section provides instructions on how to blink the user LEDs using IAR Embedded Workbench Arm® 9.32.1
programming tool with the TRAVEO™ T2G Cluster 6M Lite Kit.

2.2.1 IAR Embedded Workbench for Arm®

2.2.1.1 Setting up the IDE
Before programming and debugging the LED blinky code, follow the steps below as a one-time setup for
prerequisites and tools installation:
1. Download the latest T2G Sample Driver Library (SDL) for the TRAVEO™ T2G Cluster 6M Lite Kit to your PC
2. Install the SDL in a location outside the default program files to allow the IDE to access and create

temporary files
3. Open the Readme.pdf file available inside the SDL folder and use the provided link from that file to

download the version of IAR EWARM that is supported by that SDL version
4. Download the IAR Embedded Workbench software and run the installation. Note that it might take some

time
5. When you open the IAR EWARM for the first time, select the license in the License wizard
6. If you do not have the license, it is strongly recommended to register for a code size limited license type
7. After downloading and setting up the IDE, extract the folder available at the following path: SDL (version

7.9.0 or higher) > misc. > tools > iar > IAR_EWARM_9321_FlashLoader_Patch_TraveoII.zip
8. Follow the readme.txt document available in that folder for copying the patch files to support SDL and

the device with that IAR Embedded Workbench IDE
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The IAR Embedded Workbench for Arm® tool and T2G SDL drivers are now ready for programming and
debugging the TRAVEO™ T2G Cluster 6M Lite Kit.

2.2.1.2 Programming using the onboard debugger KitProg3
This section describes how to program the TRAVEO™ T2G Cluster 6M Lite Kit using the onboard programmer and
debugger, KitProg3. Follow the steps below to program and debug the kit using the IAR Embedded Workbench
for Arm® tool and the onboard KitProg3 programmer/debugger:
1. Connect the USB Type-C cable between the USB Type-C connector of KitProg3 (X400) and the USB port

of the PC
2. Observe that the power LEDs (D104, D102, and D103) and the VBUS LED (D400) start glowing green. If the

LEDs are not glowing, refer to the default jumper configuration table in Initial jumper configuration
3. Open the IAR Embedded Workbench 9.32.1 and navigate to File > Open Workspace.

Then, navigate to the path where you have installed the T2G SDL, and select the
following path: T2G_Sample_Driver_Library_7.9.0 > tviic2d6m > tools > iar > flash >
tviic2dd6m_flash_cm0plus_template

4. Select the lite_kit revision from the drop-down list under Workspace in the Workspace tab

Figure 16 Selecting lite_kit workspace for the Cluster 6M Lite kit in IAR
5. In the Workspace tab, expand the src folder to find the main_cm0plus.c file
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Figure 17 Opening the main C file in IAR
6. To ensure the correct debugger is selected, right-click on cm0plus – lite_kit in the Workspace window.

Choose Options, then select Debugger. Navigate to the Setup tab, and under Drivers, select the CMSIS
DAP option and press OK
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Figure 18 Checking the debugger option in IAR
7. For the build, right-click on cm0plus – lite_kit in the Workspace window and select Rebuild All
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Figure 19 Compiling and building the code in IAR
8. Now, the rebuild process will start. You can check for errors and warnings in the Build Log

Figure 20 Checking for errors and warnings in the Build Log in IAR

Note: If the Build window does not appear on the screen, go to View > Messages > Build. In the
Messages option under View, you can find the debug log, reference windows, etc

9. To load the program to the flash region of the CM0+ core, click the Download and Debug icon in the
toolbar
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Figure 21 Downloading and debugging the code in the IAR workspace
10. Click the Go icon to start the execution. You can also use the function keys in the Debug window: F5 (Go),

F10 (Step Over), F11 (Step into), and Ctrl+D (Download and Debug)

Figure 22 Running the code in the IAR workspace for the Cluster 6M Lite Kit
11. In free-running execution, the user LED1 (D900) starts blinking on the board
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Figure 23 Blinking user LED1 (D900)
12. Follow the same steps for the other CM7 core and observe that user LED 2 (D901) also starts blinking, just

like user LED1 (D900)

2.2.1.3 Programming using IAR Systems I-jet debugger
This section describes how to program the TRAVEO™ T2G Cluster 6M Lite Kit using the IAR Systems I-jet
debugger. Follow the steps below to program the kit using the IAR Embedded Workbench for ARM tool and the
IAR Systems I-jet debugger:
1. See Powering up the lite kit for instructions to power up the kit
2. After powering up the kit, ensure that you have the JTAG to 20-pin Arm® converter (ADA-MIPI20-TI14

adapter). Connect the JTAG to 20-pin Arm® converter to the Arm® Standard 20-pin JTAG connector (X302).
Then, connect the I-jet debugger to the JTAG to 20-pin Arm® converter

3. Now, open IAR Embedded Workbench 9.32.1 and navigate to File > Open Workspace.
Then, navigate to the path where you have installed the T2G SDL, and select the
following path: T2G_Sample_Driver_Library_7.9.0 > tviic2d6m > tools > iar > flash >
tviic2dd6m_flash_cm0plus_template

4. Select the lite_kit workspace for the TRAVEO™ T2G Cluster 6M Lite Kit in IAR
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Figure 24 Selecting the lite_kit workspace for the Cluster 6M Lite Kit in IAR
5. Expand the src folder in the Workspace tab to locate the main_cm0plus.c file

Figure 25 Opening the main C file in IAR
6. To ensure the correct debugger is selected, right-click on cm0plus – lite_kit in the Workspace window,

choose Options, and then select Debugger. Navigate to the Setup tab, and under Drivers, select the
I-jet option and press OK
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Figure 26 Checking the debugger option in IAR
7. For the build, right-click on cm0plus – lite_kit in the Workspace window and select Rebuild All

Figure 27 Compiling and building the code in IAR
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8. Check for errors and warnings in the Build Log as the rebuild process begins. If the build window does
not appear on the screen, go to View > Messages > Build

Figure 28 Checking for errors and warnings in build log in IAR
9. To load the program to the flash region of the CM0+ core, click the Download and Debug icon in the

toolbar

Figure 29 Downloading and debugging the code in the IAR workspace
10. Click the Go icon to start the execution. Function keys from the keyboard can also be used in the Debug

window as follows:
a. F5 (Go)
b. F10 (Step Over)
c. F11 (Step into)
d. Ctrl+D (Download and Debug)
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Figure 30 Running the code in the IAR workspace for the Cluster 6M Lite Kit
11. In free-running execution, user LED 1 (D900) starts blinking on the board

Figure 31 Blinking user LED1 (D900)

2.2.2 AutoFlashUtility
To use the AutoFlashUtility tool in this kit, follow these steps:
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1. Connect a USB Type-C cable between the USB Type-C connector for KitProg3 (X400) and your PC's USB
port to use the onboard debugger/programmer KitProg3

2. Run the commands from the command prompt to use the AutoFlashUtility tool for flashing codes
Note that the AutoFlashUtility tool does not support debugging and should be used solely for programming.

Instructions for AutoFlashUtility

openocd.exe -s ../scripts -f interface/kitprog3.cfg -f target/traveo2_6m.cfg -c "cm0_plus.hex 
verify; exit"
openocd.exe -s ../scripts -f interface/kitprog3.cfg -f target/traveo2_6m.cfg -c "cm7_0.hex 
verify; exit"

Note: Visit the Infineon AutoFlash Utility page on the web to download this tool.
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3 Funtional description
This section provides information about the major hardware blocks included in the TRAVEO™ T2G Cluster 6M
Lite Kit.
The TRAVEO™ T2G Cluster 6M Lite Kit includes:
• A TRAVEO™ T2G CYT4DN MCU
• An HDMI interface
• An EZ-USB™ FX3
• SMIF for interfacing HYPERBUS™ memory (HYPERRAM™) and octal interface (SEMPER™ NOR flash)
• An onboard programmer/debugger KitProg3
• HID interfaces
• Reset buttons
• General-purpose I/O headers

3.1 TRAVEO™ CYT4DN MCU
The TRAVEO™ T2G Cluster 6M Lite Kit is designed to evaluate the different features and functionalities of the
CYT4DN device, which belongs to the TRAVEO™ T2G Cluster family. The CYT4DN family of TRAVEO™ T2G
microcontrollers is dedicated to automotive systems such as instrument clusters and Head-Up Displays (HUD).
The CYT4DN includes:
• A 2D graphics engine
• Sound processing capabilities
• Two 320 MHz Arm® Cortex®-M7 CPUs for primary processing
• One 100 MHz Arm® Cortex®-M0+ CPU for peripheral and security processing
These devices also feature embedded peripherals that support:
• Controller Area Network with Flexible Data Rate (CAN FD)
• Local Interconnect Network (LIN)
• Clock Extension Peripheral Interface (CXPI)
• Gigabit Ethernet
The CYT4DN package used in the Cluster 6M Lite Kit is a 327-pin BGA. Due to design limitations and the
availability of certain peripherals and pins, some functionalities and features supported by the TRAVEO™ T2G
CYT4DN device may not be available on the Lite Kit.
Figure 32 shows the block diagram of the TRAVEO™ T2G CYT4DN MCU.
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Figure 32 TRAVEO™ T2G CYT4DN block diagram

Table 5 shows the MCU device description.

Table 5 MCU device description

Reference Manufacturer Part number Package, size

U200 Infineon Technologies CYT4DN 327- Ball BGA

Figure 33 shows the location of the CYT4DN device (MCU) in this kit.
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Figure 33 CYT4DN device location

3.2 Power supply block
This kit includes onboard power management ICs (PMICs) and LDOs to generate the necessary power supplies
for operating the TRAVEO™ T2G CYT4DN MCU and other peripherals. The buck regulator and LDOs take a 5 V
input from the USB connectors to produce the voltages required for various peripherals on this kit.
Figure 34 illustrates the kit's power supply block.
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Figure 34 Power supply block diagram

In this kit, the IR3883 buck regulator is used for 5 V DC to 3.3 V DC conversion, and the TPS62A02DRLR buck
regulator is used for 3.3 V DC to 1.1 V DC conversion. The primary supply comes from the IR3883 buck regulator.
3.3 V PMIC: The IR3883 buck regulator supports a wide input voltage range of 2.5 V to 14 V with an external Vcc
and a single input voltage range of 4.5 V to 14 V. The IR3883 is an easy-to-use, fully integrated, and highly
efficient monolithic DC-DC regulator. The on-chip PWM controller and MOSFETs make the IR3883 a space-
efficient solution, providing accurate power delivery. See the References section for the IR3883 buck regulator
details and datasheet.
1.1 V PMIC: The TPS62A02DRLR buck regulator is optimized for generating low output voltages down to 0.8 V.
The supply voltage range is from 2.7 V to 5.5 V, allowing for the use of a single Li+ cell, three NiMH cells, or a
regulated 5 V input. See the References section for the TPS62A02DRLR buck regulator details and datasheet.
LDO: This kit includes other power LDOs to generate the power supply for various peripherals. The board
generates a 1.2 V voltage rail for the FX3 peripheral and a 1.8 V voltage rail for HDMI.
In this kit, the TLS205B0 adjustable version low dropout voltage regulator is used for generating power supplies
of 1.2 V and 1.8 V. TLS205B0 is a micropower, low noise, low-dropout voltage regulator. The device can supply
an output current of 500 mA with a dropout voltage of 320 mV. See the References section for TLS205B0 details
and datasheet.
Figure 35 shows the location of different PMICs and LDOs in the Cluster 6M Lite Kit.
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Figure 35 PMIC and LDO location

3.3 Clocks
This section provides information about the various crystal oscillators on the TRAVEO™ T2G Cluster 6M Lite Kit,
which are used for clocking the TRAVEO™ T2G CYT4DN MCU and other peripherals.

Table 6 Crystals available in this kit

Crystal oscillator Reference designator Frequency

Watch Crystal Oscillator (WCO for MCU) Y300 32.768 kHz

External Crystal Oscillator (ECO for MCU) Y301 16 MHz

Crystal oscillator for EZ-USB™ FX3* Y500 19.2 MHz

Crystal oscillator for LVDS to HDMI converter Y700 25 MHz

Crystal oscillator for Ethernet transceiver Y1000 25 MHz

Figure 36 and Figure 37 shows the location of the crystal oscillators in this kit.
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Figure 36 Crystals location-Top

Figure 37 Crystal location-Bottom
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3.4 Reset button
There are two reset buttons on the board: the S200 button for resetting the TRAVEO™ T2G CYT4DN MCU and the
S500 button for resetting the FX3.
The reset button (S200) is specifically designed to reset the TRAVEO™ T2G CYT4DN MCU and is connected to the
XRES pin of the MCU via a 10K resistor. To reset the TRAVEO™ T2G CYT4DN MCU, simply press and release the
S200 button once, which will connect the XRES pin to ground, initiating the reset process.
• S200: CYT4DN MCU reset
• S500: FX3 reset
Figure 38 shows the locations of these reset buttons on the kit.

Figure 38 Reset buttons

3.5 Human Interface Devices (HID)
The TRAVEO™ T2G Cluster 6M Lite Kit supports several Human Interface Devices (HIDs) for user interaction.
These include three user LEDs (D900, D901, D902), two push buttons (S900, S901), and a potentiometer (R904).
These interfaces are intended to facilitate use of the kit for developers and testers, allowing them to perform
various operations and tests.

Table 7 MCU port pin details

Pin Net RefDes

P0[2] BUTTON1 USER BUTTON1 (S900)

P0[3] BUTTON2 USER BUTTON2 (S901)
(table continues...)
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Table 7 (continued) MCU port pin details

Pin Net RefDes

P7[5] LED1 LED1 (D900)

P7[6] LED2 LED2 (D901)

P7[7] LED3 LED3 (D902)

P7[4] POT POT (R904)

Figure 39 shows the location of the user LEDs, push buttons, and potentiometer in this kit.

Figure 39 User LEDs, push buttons, and potentiometer in the Cluster 6M Lite Kit

3.5.1 User LEDs
The LEDs D900, D901, and D902 (LED-SMD-LTST-C150KGKT) on the TRAVEO™ T2G Cluster 6M Lite Kit can operate
across the entire voltage range of VDD. These LEDs function as active HIGH, meaning they require the pins to
supply VDD to turn them ON.

3.5.2 User push button
The user push buttons S900 and S901 (PTS810 SJG 250 SMTR LFS) on the TRAVEO™ T2G Cluster 6M Lite Kit
provide input to the TRAVEO™ T2G CYT4DN MCU. By default, pressing these buttons connects the TRAVEO™ T2G
CYT4DN MCU pin to ground.
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3.5.3 Potentiometer
The TRAVEO™ T2G Cluster 6M Lite Kit features a 10 kΩ potentiometer (R904, POT-THT-3362P) connected to the
TRAVEO™ T2G CYT4DN MCU. This potentiometer is used to simulate an analog sensor output to the TRAVEO™

T2G CYT4DN MCU. The VDDA power reference is provided to the potentiometer, so any change in its position
affects the ADC conversion result accordingly.

3.6 Graphics and video interface
The TRAVEO™ T2G Cluster 6M Lite Kit supports various video-compatible interfaces accessible via specific
connectors and compatible with components such as displays, cameras, and adapter boards.
Figure 40 shows the different video and graphic interfaces available in this kit.

Figure 40 Video interfaces

3.6.1 EZ-USB™ FX3 interface
This kit supports the FX3 video interface via a Type-C connector for streaming graphics output to a screen. It is a
plug-and-play device, as the EZ-USB™ FX3 comes with the necessary firmware preloaded. The RGB display
signals from the CYT4DN device are converted into USB 3.0 packets by the FX3 and streamed to a PC. The PC
detects the FX3 as a standard USB camera, so any suitable video rendering application can display the
streamed graphics.
For streaming, use VLC media player (see Preprogrammed firmware for configuring the media player and FX3)
or a Python script mentioned in Python script for streaming with FX3 to stream the graphics output.
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Note: For further information about programming the EZ-USB™ FX3, see Programming the EZ-USB™ FX3.

Figure 41 shows the connection of the Type-C cable required to stream FX3 to a PC. Ensure that jumper X502 is
not shorted in this kit.

Figure 41 Connection required to stream FX3 to a PC

Note: To stream the graphics output via EZ-USB™ FX3, remove the jumper X502 (highlighted in Figure 41)
from the board.

3.6.2 HDMI interface
The TRAVEO™ T2G Cluster 6M Lite Kit includes one HDMI interface and supports graphics output. To stream
graphics output, connect the HDMI cable between X700 and the display.
The IT6263 (U700) is a high-performance single-chip LVDS to HDMI converter. It combines an LVDS receiver and
an HDMI 1.4a transmitter, supporting LVDS input and HDMI 1.4 output through its conversion function. The
built-in LVDS receiver can support single-link and dual-link LVDS inputs, while the built-in HDMI transmitter is
fully compliant with HDMI 1.4a. With a high-speed LVDS RX, the IT6263 can support resolutions up to 1080P and
10-bit deep colors.

TRAVEO™ T2G Cluster 6M Lite Kit user guide
KIT_T2G_C-2D-6M_LITE
3  Funtional description

User guide 40 002-39885 Rev. *A
2025-02-06



Figure 42 Location of the HDMI connector on the Cluster 6M Lite Kit

3.6.3 MIPI-CSI2 interface
The TRAVEO™ T2G Cluster 6M Lite Kit supports the MIPI-CSI2 interface. Since the Camera Serial Interface (CSI2)
receiver is part of the CYT4DN device, you need an external camera module to transmit the video stream to the
device. The MIPI-CSI2 interface (X701) supports all imaging formats like YUV, RGB, and RAW.

TRAVEO™ T2G Cluster 6M Lite Kit user guide
KIT_T2G_C-2D-6M_LITE
3  Funtional description

User guide 41 002-39885 Rev. *A
2025-02-06



Figure 43 Location of the MIPI-CSI2 Interface on the Cluster 6M Lite Kit

3.7 Communication interface
The TRAVEO™ T2G Cluster 6M Lite Kit offers a range of communication interfaces, including I2C, SPI, UART, and
Ethernet. These interfaces can be used for various purposes, such as connecting to external devices or
communicating with other systems.

3.7.1 Ethernet
The TRAVEO™ T2G Cluster 6M Lite Kit includes an onboard Ethernet PHY (X1000). The Realtek RTL8211FI (U1000)
is a highly integrated Ethernet transceiver that supports RGMII with 10Base-T, 100Base-TX, and 1000Base-T IEEE
802.3 standards. It provides all the necessary physical layer functions to transmit and receive Ethernet packets
over CAT.5 UTP cable. The RTL8211FI is housed in a 40-pin QFN green package.
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Figure 44 Location of the Ethernet PHY on the Cluster 6M Lite Kit

3.8 Serial memory interface
The TRAVEO™ T2G Cluster 6M Lite Kit includes a serial memory interface (SMIF) that serves as a master,
providing a low pin count connection to off-chip SPI devices such as EEPROM, FRAM, MRAM, or NAND
memories, in SDR or DDR mode, and HYPERBUS™ devices such as HYPERFLASH™ (NOR Flash) and HYPERRAM™

(Pseudo Static RAM). SMIF provides two modes for data transfer operation to and from external devices.
The TRAVEO™ T2G Cluster 6M Lite Kit has two SMIF devices:
• SEMPER™ NOR flash (S28HS) connected to the SMIF-0 instance
• HYPERRAM™ (S27KS) connected to the SMIF-1 instance
Figure 45 shows the locations of SEMPER™ flash and HYPERRAM™ mounted in this kit.
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Figure 45 SEMPER™ flash and HYPERRAM™ location

3.8.1 HYPERFLASH™

This kit includes an S28HS512T 512 Mb SEMPER™ flash (U600). The Infineon SEMPER™ flash family consists of
high-speed CMOS, MIRRORBIT™ NOR flash devices that comply with the JEDEC JESD251 eXpanded SPI (xSPI)
specification. SEMPER™ flash is designed for functional safety and is developed according to the ISO 26262
standard to achieve ASIL-B compliance and ASIL-D readiness.
SEMPER™ flash with HYPERBUS™ interface devices support both the HYPERBUS™ interface and legacy (x1) SPI.
Both interfaces serially transfer transactions, reducing the number of interface connection signals.

3.8.2 HYPERRAM™

This kit includes an S27KS0642 64 Mb HYPERRAM™ (U601) self-refresh DRAM (PSRAM). The Infineon 64 Mb
HYPERRAM™ device is a high-speed CMOS, self-refresh DRAM with a HYPERBUS™ interface. The DRAM array uses
dynamic cells that require periodic refresh.
The refresh control logic within the device manages the refresh operations on the DRAM array when the
memory is not actively read or written by the HYPERBUS™ interface master (host). Since the host is not required
to manage any refresh operations, the DRAM array appears to the host as though the memory uses static cells
that retain data without refresh. Thus, the memory is more accurately described as Pseudo Static RAM (PSRAM).

Note: For the datasheet and more details about SEMPER™ flash and HYPERRAM™, see References.
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3.9 Program and debug interface
The TRAVEO™ T2G Cluster 6M Lite Kit includes an onboard programmer/debugger, KitProg3, with a USB Type-C
connector (X400) for programming and debugging the CYT4DN device. Additionally, you can use the Arm®

Standard 20-pin JTAG connector (X302) to program and debug the CYT4DN device.

3.9.1 PSOC™ 5LP (KitProg3)
The KitProg3 (onboard programmer/debugger) is implemented using a PSOC™ 5LP device (CY8C5868LTI-LP039).
ThePSOC™ 5LP is responsible for implementing the low-level communication firmware for programming and
debugging, facilitating communication between a programming tool and a target, such as the TRAVEO™ T2G
Cluster 6M Lite Kit.
In this kit, the KitProg3 is pre-configured to function as a USB-UART bridge for programming and debugging the
CYT4DN device. The kit also includes a KitProg3 mode switch (S400) and a KitProg3 status LED (D401). These
interfaces allow you to switch between various modes of operation of KitProg3 and use the LED to monitor its
status. Note that this board supports only CMSIS-DAP BULK mode.
Additionally, there is an optional programming header for programming the PSOC™ 5LP, accessible via the 5-pin
header (X401). It is important to note that the KitProg3 hardware revision ID is 0x08.
To use the onboard programmer/debugger KitProg3 on the TRAVEO™ T2G Cluster 6M Lite Kit, simply connect
the USB Type-C cable to the USB connector (X400) and the USB port of your PC for programming and
debugging.
KitProg3 uses the industry-standard SWD protocol, supporting CMSIS-DAP V2.0.0 and V1.2.0 as the bulk and HID
endpoint transport mechanisms.
Figure 46 shows how to connect this kit to the PC for programming and debugging through KitProg3.
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Figure 46 KitProg3 USB-UART bridge connected to the PC

3.9.2 Arm® standard SWD/JTAG interface
When it comes to programming and debugging the kit using the Arm® Standard 20-pin JTAG connector, you
have a couple of options. Firstly, you can use the GHS Probe directly by connecting it to the Arm® Standard 20-
pin JTAG connector (X302). Alternatively, you can use the JTAG-to-20-pin Arm® converter (I-jet MIPI20 to Arm® 20
adapter) to connect the I-jet with the Arm® Standard 20-pin JTAG connector (X302), enabling you to program
and debug with the I-jet debugger.
Figure 47 shows the JTAG connector X302.
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Figure 47 Connecting the GHS Probe to the JTAG header X302

3.10 General-purpose I/O headers
The TRAVEO™ T2G Cluster 6M Lite Kit provides a variety of general-purpose I/O headers compatible with
popular interfaces. These include a Raspberry Pi I/O header, an Arduino header, a mikroBUS header, and two
Shield2Go footprints. This kit also supports various shields to use different peripherals that are not available on
the board but can be connected to the I/O headers of the kit.
Figure 48 shows the locations of the different headers in this kit.
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Figure 48 Expansion headers

3.10.1 Raspberry Pi header

Table 8 Raspberry Pi header pin details

Pin MCU port pin Functionality Pin MCU port pin Functionality

X800.1 - 3V3 X800.21 P11[0] SCB0_MISO

X800.2 - 5V0 X800.22 P16[6] RPI_GPIO9/P16.6

X800.3 P0[4] SCB11_SDA X800.23 P11[2] SCB0_CLK

X800.4 - 5V0 X800.24 P11[1] SCB0_SEL0

X800.5 P0[5] SCB11_SCL X800.25 - GND

X800.6 - GND X800.26 P12[0] SCB0_SEL3

X800.7 P9[2] RPI_GPIO1 X800.27 P0[4] SCB11_SDA

X800.8 P29[0] SCB9_RX X800.28 P0[5] SCB11_SCL

X800.9 - GND X800.29 P9[6] RPI_GPIO5

X800.10 P29[1] SCB9_TX X800.30 - GND

X800.11 P9[3] RPI_GPIO2 X800.31 P9[7] RPI_GPIO6

X800.12 P15[7] TDM_TX_SCK0 X800.32 P15[5] RPI_GPIO8/P15.5
(table continues...)
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Table 8 (continued) Raspberry Pi header pin details

Pin MCU port pin Functionality Pin MCU port pin Functionality

X800.13 P9[4] RPI_GPIO3 X800.33 - TDM_RX_MCK0_RPI

X800.14 - GND X800.34 - GND

X800.15 P9[5] RPI_GPIO4 X800.35 P16[0] TDM_TX_FSYNC0

X800.16 - TDM_RX_SCK0_RPI X800.36 P11[4] RPI_GPIO7

X800.17 - 3V3 X800.37 - TDM_RX_FSYNC0_RPI

X800.18 P15[6] TDM_TX_MCK0 X800.38 P16[5] TDM_RX_SD0

X800.19 P11[3] SCB0_MOSI X800.39 - GND

X800.20 - GND X800.40 P16[1] TDM_TX_SD0

3.10.2 Arduino UNO header

Table 9 Arduino header X803 and X802 pin details

Pin Functionality Pin Functionality

X803.1 VIN X802.1 LIN0_TX

X803.2 GND X802.2 LIN0 _RX

X803.3 GND X802.3 SCB8_SEL0

X803.4 5V0 X802.4 SCB8_MOSI

X803.5 3V3 X802.5 SCB8_MISO

X803.6 XRES# X802.6 SCB8_CLK

X803.7 VDDIO_GPIO X802.7 GND

X803.8 NC X802.8 VADC

X802.9 SCB11_SCL

X802.10 SCB11_SDA

Table 10 Arduino header X805 and X806 pin details

Pin Functionality Pin Functionality

X805.1 AN1_ARD X806.1 SCB10_SCL/LIN1_RX

X805.2 AN2_ARD X806.2 SCB10_SDA/LIN1_TX

X805.3 AN3_ARD X806.3 DAC_COM_L

X805.4 AN4_ARD X806.4 GPIO3_ARD

X805.5 SCB11_SDA X806.5 CAN0_0_TX

X805.6 SCB11_SCL X806.6 CAN0_0_RX

X805.7 DAC_AOUTS_R X806.7 GPIO2_ARD

X805.8 DAC_AOUTS_L X806.8 GPIO1_ARD

X805.9 DAC_COM_R
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3.10.3 mikroBUS header

Table 11 mikroBUS header X812 and X813 pin details

Pin Functionality Pin Functionality

X812.1 AN1_MB X813.1 GPIO1_MB

X812.2 XRES# X813.2 GPIO2_MB

X812.3 SCB0_SEL3 X813.3 SCB9_RX

X812.4 SCB0_CLK X813.4 SCB9_TX

X812.5 SCB0_MISO X813.5 SCB11_SCL

X812.6 SCB0_MOSI X813.6 SCB11_SDA

X812.7 3V3 X813.7 5V0

X812.8 GND X813.8 GND

3.10.4 Shield2Go header
Shield2Go footprints are available on this kit, and you can mount the headers as needed.

Table 12 Shield2Go S800 and S801 pin details

Pin Functionality Pin Functionality

S800.1/S801.1 5V S800.10/S801.10 RX

S800.2/S801.2 AN1 S800.11/S801.11 TX

S800.3/S801.3 AN2 S800.12/S801.12 RST/GPIO2

S800.4/S801.4 SDA S800.13/S801.13 GPIO1

S800.5/S801.5 SCL S800.14/S801.14 CS

S800.6/S801.6 GND S800.15/S801.15 SCLK

S800.7/S801.7 3V3 S800.16/S801.16 MOSI

S800.8/S801.8 INT/GPIO3 S800.17/S801.17 MISO

S800.9/S801.9 PWM/GPIO4
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4 Additional information

4.1 Test points
Table 13 describes the test points available on the TRAVEO™ T2G Cluster 6M Lite Kit.

Table 13 Available test points

Sl. no. Test points Description

1 TP501 FX3 UART_RX

2 TP502 FX3 UART_TX

3 TP600 SMIF0 RWDS

4 TP602 SMIF0 CLK

5 TP603 SMIF0 DATA0

6 TP604 SMIF0 DATA1

7 TP605 SMIF0 DATA2

8 TP606 SMIF0 DATA3

9 TP607 SMIF0 DATA4

10 TP608 SMIF0 DATA5

11 TP609 SMIF0 DATA6

12 TP610 SMIF0 DATA7

13 TP611 SMIF1 DATA0

14 TP612 SMIF1 DATA1

15 TP613 SMIF1 SEL0

16 TP614 SMIF1 DATA2

17 TP615 SMIF1 CLK

18 TP616 SMIF1 DATA3

19 TP617 SMIF1 DATA4

20 TP618 SMIF1 DATA5

21 TP619 SMIF1 DATA6

22 TP620 SMIF1 DATA7

23 TP621 SMIF1 RWDS

24 TP622 SMIF0 SEL0

4.2 Advanced features

4.2.1 Programming the EZ-USB™ FX3
To program the EZ-USB™ FX3, follow the procedure outlined in this section. Before proceeding, ensure you have
downloaded the necessary software required to program the FX3. It is recommended to use the FX3 software
development kit (FX3 SDK), which includes tools, drivers, and application examples, to program and utilize the
EZ-USB™ FX3.
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Steps to program FX3:
1. Install the FX3 SDK on your PC for drivers and programming tools
2. Program the FX3

Notes:
1. Once the FX3 is reprogrammed, the default FX3 video streaming will stop working
2. See References to get the link for downloading the FX3 SDK. For more details about FX3 and its usage, refer

to the links provided there

4.2.1.1 Installing the FX3 SDK
1. Download the FX3 SDK
2. After downloading it from the web, unzip the file and open the FX3 SDK Setup application
3. In the Installation Type tab of the SDK window, select your preferred option (in this example, the Custom

option is selected), and then click Next
4. In the Selected Release table, do not select or deselect or change anything. Follow the default setup

and click Next
5. Carefully read and accept the terms and conditions, then click Next
6. Follow the same process for the subsequent steps and wait for the window to show the installation

status
7. After the installation is complete, a window with Contact Information will pop up; fill it in and click

Finish
8. Your FX3 SDK installation is now complete

4.2.1.2 Programming the FX3 using Control Center
1. Before programming the FX3, ensure that you have connected the jumper X502 on the board to switch

the FX3 to Bootloader mode
2. Next, connect the USB Type-C cable between the USB Type-C connector (X500) on the board and the USB

3.0 port on your PC. Then, press the FX3 Reset button (S500) on the board
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Figure 49 Shorting the jumper X502 and pressing the reset button in the Cluster 6M
Lite Kit

3. Open the search tab and search for Control Center. If you cannot find it, navigate to Start > All apps >
Cypress, and open it
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Figure 50 Opening Control Center for programming FX3
4. Select the Cypress FX3 USB Bootloader Device in the Control Center. Then navigate to Program > FX3,

and select I2C EEPROM
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Figure 51 Programming EZ-USB™ FX3
5. You will now be prompted for the location of the UVC image to flash into FX3. Locate the directory where

you have generated or downloaded the UVC_Traveo.img firmware. After selecting that image, check the
status of the flashing in the bottom left of the Control Center.
Note: The UVC_Traveo.img file will not be provided. Users can create their own .img file to program
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Figure 52 Flashing UVC image into FX3
6. When the status shows Programming of I2C EEPROM Succeeded, the FX3 is programmed. You can now

close the Control Center tab and remove the X502 jumper from the 6M kit.
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Figure 53 Programing of FX3 is complete
7. If you have connected the X502 jumper on the 6M board, you should see the device Cypress FX3 USB

Boot Programmer Device listed under the Universal Serial Bus controllers tab in the Device Manager,
as shown in Figure 54
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Figure 54 EZ-USB™ FX3 under Universal Serial Bus Controllers
8. If you remove the X502 jumper from your 6M board, note the FX3 device under Cameras in the Device

Manager, as shown in Figure 55. Before or after removing the X502 jumper, disconnect and reconnect the
power to the 6M kit to see the devices listed under these tabs in the Device Manager
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Figure 55 EZ-USB™ FX3 coming under Camera in Device Manager

4.2.2 Python script for streaming with FX3
This section provides a step-by-step guide on how to integrate the Python script for streaming the FX3 device as
a camera, including necessary code snippets or references to relevant code files that need to be added or
modified.
Points to remember when working with the FX3 device:
• The onboard FX3 acts as a camera when the USB Type-C cable is connected between the kit and the

USB 3.0 port of the PC. To ensure a proper connection, FX3 must be listed under 'Cameras' in the Device
Manager. If it is not listed, it is recommended to install the latest FX3 drivers

• Any video streaming application or script on the PC can be used to view the output from FX3. However,
playback performance may vary depending on the color formats and the application used

• A simple Python-based script is provided below as a sample. The script has been tested on Python 3.11,
and it is recommended to use this version of Python

4.2.2.1 One-time setup of the Python script
1. Install Python 3.11 on your PC
2. Install the necessary packages using pip:

• configparser (v)
• pygrabber (v)
• OpenCV-python (v)

3. Create a directory named FX3_Capture on the C drive of Windows
4. In this directory, create a file named FX3_Capture.py
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5. Also, create a text file in this directory named FX3_Capture_Config.txt
6. Copy the FX3_Capture_Config.txt code into the FX3_Capture_Config.txt file and save it
7. Copy the complete code mentioned in Python script for FX3 capture to the python file FX3_Capture.py

and save it
8. Open the terminal from this directory and run the command Python FX3_Capture.py
9. You will see a message pop-up in the terminal asking you to enter the index for FX3 as listed in the

Available capture sources. Enter the FX3 index number
10. Upon pressing Enter, if the T2G-C-2D-6M MCU is set to the resolution and frame rate as mentioned in

FX3_Capture_Config.txt, the output will be displayed in a new window on the PC screen
11. If a frame is occasionally missed by the PC, the script will automatically re-open the new window on the

PC screen
12. If the new window does not open even after verifying the resolution, press the FX3 reset button (S500) on

the Lite Kit. This should allow the FX3 to stream video properly if it is in a hung state

FX3_Capture_Config.txt

[Frame_Options] 
Frame_Width = 800 
Frame_Height = 480 
Frame_Rate = 60 
Windows = 1

4.2.2.2 Python script code for streaming FX3 as a camera
Figure 56 illustrates the process of the Python script for streaming the FX3 as a camera.
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Figure 56 Flowchart of the Python script for FX3

The Python script for FX3 capture code should be copied into the FX3_Capture.py file as described above.
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Python script for FX3 capture

# Import required packages
from configparser import ConfigParser, ExtendedInterpolation
from pygrabber.dshow_graph import FilterGraph
import sys
import cv2
import os
import time

mypath = os.path.dirname(__file__)
os.chdir(mypath) #This is necessary to support script to be run from anywhere

FX3CfgFileObj = ConfigParser(interpolation=ExtendedInterpolation())
FX3CfgFileObj.read('FX3_Capture_Config.txt')

Frame_Width  = FX3CfgFileObj.get('Frame_Options', 'Frame_Width')
Frame_Height = FX3CfgFileObj.get('Frame_Options', 'Frame_Height')
Frame_Rate   = FX3CfgFileObj.get('Frame_Options', 'Frame_Rate')
Windows      = FX3CfgFileObj.get('Frame_Options', 'Windows')
Windows      = int(Windows)

# Creating empty buffers for video data
UsrInput           = [0] * Windows
CaptureSourceIndex = [0] * Windows
CaptureObject      = [0] * Windows
FrameValid         = [0] * Windows
Frame              = [0] * Windows

# Creating a counter to record number of re-tries (in case of stream freeze)
retryCounter = 0

graph = FilterGraph()
CaptureSourceList = graph.get_input_devices()

# Check whether the capture sources are available on the machine
if (len(CaptureSourceList) == 0):
    print("No valid capture sources found. Exiting application...")
    sys.exit()
print("\n\nPython Streaming Application for FX3\n\n")

print("Available capture sources:")
for Index, CaptureSource in enumerate(CaptureSourceList):
    print(Index , " - ", CaptureSource)

for WinNum in range (0, Windows):
    print("\nPlease enter the Capture source index you want to use for stream - ", WinNum)
    UsrInput[WinNum] = input()

for WinNum in range (0, Windows):
    CaptureSourceIndex[WinNum] = int(UsrInput[WinNum])
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# Check whether the capture sources index is out of range
for WinNum in range (0, Windows):

    if CaptureSourceIndex[WinNum] not in range(0, len(CaptureSourceList)):
        print("\n\n Error! Source ", CaptureSourceIndex[WinNum] , " is invalid, Please select a 
valid source. Exitting application.\n\n")
        sys.exit()

for WinNum in range (0, Windows):

    # Create the video capture object
    CaptureObject[WinNum] = cv2.VideoCapture(CaptureSourceIndex[WinNum] + cv2.CAP_ANY )  
    #Set the Frame Width
    CaptureObject[WinNum].set(cv2.CAP_PROP_FRAME_WIDTH, int(Frame_Width))
    #Set the Frame Height
    CaptureObject[WinNum].set(cv2.CAP_PROP_FRAME_HEIGHT, int(Frame_Height))
    #Set the Frame rate
    CaptureObject[WinNum].set(cv2.CAP_PROP_FPS, int(Frame_Rate))

    print("\nPress any key on the video window to exit the application")

# Display the received frames in an infinite loop
while (True):

    for WinNum in range (0, Windows):
        FrameValid[WinNum], Frame[WinNum] = CaptureObject[WinNum].read()
        #Flip the frame horizontally
        Frame[WinNum] = cv2.flip(Frame[WinNum],1)
        #Rotate the frame by 180degrees
        Frame[WinNum] = cv2.rotate(Frame[WinNum], cv2.ROTATE_180)

        StreamName = "Live Stream" + str(WinNum)

        if FrameValid[WinNum]:
            cv2.imshow(StreamName, Frame[WinNum])
            retryCounter = 0        # Reset the counter

            #User input to press any to exit the video stream
            UserInput = cv2.waitKey(1)
            if UserInput > 0:
                print("\nKey press detected. \n")
                CaptureObject[WinNum].release()
                cv2.destroyAllWindows()
                print("\nStream closed. \n")
                sys.exit()
                break
        else:
            retryCounter = retryCounter + 1
            print("\nFrame capture failed. Retry...",retryCounter,"\n")
            CaptureObject[WinNum].release()
            cv2.destroyAllWindows()
            
            # Redo the entire capture setup
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            CaptureObject[WinNum] = cv2.VideoCapture(CaptureSourceIndex[WinNum] + cv2.CAP_ANY 
)  
            CaptureObject[WinNum].set(cv2.CAP_PROP_FRAME_WIDTH, int(Frame_Width))
            CaptureObject[WinNum].set(cv2.CAP_PROP_FRAME_HEIGHT, int(Frame_Height))
            CaptureObject[WinNum].set(cv2.CAP_PROP_FPS, int(Frame_Rate))
            time.sleep(0.1)
            
            if (retryCounter > 10):
                print("\nAll retry attempts failed. Check input stream.\n")
                CaptureObject[WinNum].release()
                cv2.destroyAllWindows()
                sys.exit()
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5 Schematic and board designs

5.1 Board images

Figure 57 Top view of the Cluster 6M Lite Kit
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Figure 58 Bottom view of the Cluster 6M Lite Kit

5.2 Schematics
The schematics for the TRAVEO™ T2G Cluster 6M Lite Kit is documented in this section.
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Figure 61 TVII-272 MCU power schematic
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Figure 64 FX3 schematic
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Figure 65 Serial memory interface schematic
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Figure 67 Schematic of the I/O headers
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Figure 68 Reset button, LEDs, and potentiometer schematic
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Figure 69 Schematic of the Reset button, LEDs, and potentiometer
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5.3 Assembly drawings

Figure 70 Primary assembly drawing of the Cluster 6M Lite Kit
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Figure 71 Secondary assembly drawing of the Cluster 6M Lite Kit

5.4 Bill of materials
The complete bill of materials is available in the download section of the Infineon homepage. A log-in is
required to download this material.

Table 14 An example of the bill of materials (BOM) for the most important or critical parts of the
evaluation or reference board

S
No.

Reference designator Item name Description

1   Printed circuit
assembly

ASSY, PCBA, KIT_T2G_C-2D-6M_LITE

2 U501 Miscellaneous IC, USB, POSITIVE OVER VOLTAGE/CURRENT
PROTECTION, 5PIN, TSOP

3 U502 EEPROM EEPROM, IC, 2MBIT, 1MHZ, 8PIN, SOIC

4 D403, D502 Miscellaneous IC, ESD, 6V, 2LINE, 6PIN, SOT-23

5 U601 Cypress IC, INFINEON, PSRAM, 3.0 V, 66 Mbit, 166
MHz, FBGA24

(table continues...)
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Table 14 (continued) An example of the bill of materials (BOM) for the most important or
critical parts of the evaluation or reference board

S
No.

Reference designator Item name Description

6 U503 Miscellaneous Type-C Dual Role Port Controller with
USB3.1 Gen1.5 Gbps Mux

7 U700 Miscellaneous IC, LVDS to HDMI converter, 64QFN

8 U105 Regulator,
switching

IC, REG, BUCK, 2A, SOT563

9 R403,R408,R510,R541,R707 Fixed resistor RES, 100K OHM, 1%, 100PPM, 1/16W, 0402

10 R525 Fixed resistor RES, 6.04K OHM, 1%, 100PPM, 1/10W, 0402,
SMD

11 R401,R402, R708 Fixed resistor RES, 22 OHM, 1%, 100PPM, 1/16W, 0402

12 R405 Resistor RES, 49.9K OHM, 1%, 100PPM, 1/16W, 0402,
SMD

13 R101,R905 Resistor RES, 1K OHM, 1%, 100PPM, 1/16W, 0402,
SMD

14 R113 Fixed resistor RES, 91K OHM, 1%, 100PPM, 1/16W, 0402,
SMD

15 R201,R202 Resistor RES, 0.0 OHM, 1/8W, 0603, SMD

16 R305,R306, R307, R308, R322, R323,
R705, R706, R1000, R1002, R1005,
R1006, R1012, R1015, R1019, R1020,
R1022, R1023

Resistor RES, 4.7K OHM, 1%, 100PPM, 1/10W, 0402,
SMD

17 R536,R537 Resistor RES, 10K OHM, 1%, 100PPM, 1/10W, 0603,
SMD

18 R200, R301, R302, R303, R311, R312,
R313, R314, R320, R321, R501, R801,
R803, R805, R810, R811, R812

Resistor RES, 0.0 OHM, 1%, 1/16W, 0402, SMD

19 R526 Resistor RES, 200 OHM, 1%, 1/10W, 0402, SMD

20 R531 Resistor RES, 330 OHM, 1%, 1/16W, 0402, SMD

21 R123,R124 Resistor RES, 470 OHM, 1%, 1/10W, 0402, SMD

22 R116 Resistor RES, 33K OHM, 1%, 0402, 1/16W

23 R410,R412 Resistor RES, 30K OHM, 1%, 1/16W, 0402, SMD

24 R413, R414, R508,R509 Resistor RES, 5.1K OHM, 1%, 1/16W, 0402, SMD

25 R300,R409,R411 Resistor RES, 15K OHM, 1%, 1/16W, 0402, SMD

26 R304,R901, R908 Resistor RES, CHIP, 20 OHM, 5%, 1/16W, 0402

27 R119, R120, R121 Resistor RES, 220 OHM, 1%, 1/10W, 0402, SMD

28 R102 Resistor RES, 47K OHM, 1%, 1/16W, 0402, SMD

29 R118 Resistor RES, 68K OHM, 1%, 1/16W, 0402, SMD
(table continues...)
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Table 14 (continued) An example of the bill of materials (BOM) for the most important or
critical parts of the evaluation or reference board

S
No.

Reference designator Item name Description

30 R105 Resistor RES, 16.5K OHM, 1%, 1/16W, 0402

31 R107 Resistor RES, 2.94K OHM, 1%, 1/16W, 0402

32 R500 Resistor RES, 910K OHM, 1%, 1/16W, 0402

33 R542,R543 Resistor RES, 2K OHM, 1%, 1/16W, 0402, SMD

34

35 R404, R407 Fixed resistor RES, 750 OHM, 1%,100PPM, 1/10W, 0603,
SMD

36 R904 VARIABLE
RESISTOR

RES, TRIMMER, 10K OHM, 0.5W, PC PIN, TOP

37 R115, R203, R502, R504, R600, R601,
R602, R604, R606, R701, R702, R704,
R900, R907

Resistor RES, 10K OHM, 1%, 100PPM, 1/16W, 0402,
SMD-AUTO

38 RA500, RA501, RA502, RA503, RA1001,
RA1002

Resistor array RES, ARRAY 8, 22 OHM, 5%, 1/16W, 1606

39 C116, C525, C714, C717, C726 Ceramic capacitor CAP, CER, 2.2uF, 10%, 16V, X5R, 0603

40 C200, C207 Ceramic capacitor CAP, CER, 47uF, 10%, 6.3V, X7R, 1210

41 C105,C400, C402, C403, C405, C407,
C409, C411, C412, C413, C414, C416,
C418, C533, C728

Ceramic capacitor CAP, CER, 1uF, 10%, X7R, 25V, 0603

42 C102, C130, C216, C217, C401, C510,
C512, C515, C516, C517, C518, C519,
C520, C521, C531, C1000

Ceramic capacitor CAP, CER, 10nF, 10%, X7R, 50V, 0402

43 C119, C120, C121, C132, C229, C230,
C532

Ceramic capacitor CAP, CER, 22uF, 20%, 16V, X5R, 0805

44 C103 Ceramic capacitor CAP, CER, 2.2uF, 10%, 25V, X5R, 0603

45 C711 Ceramic capacitor CAP, CER, 4.7UF, 20%, 16V, X5R, 0805

46 C108,C109 Ceramic capacitor CAP, CER, 22UF, 10%, X7R, 16V, 1210

47 C104 Ceramic capacitor CAP, CER, 47UF, 20%, X5R, 16V, 1206

48 C117 Ceramic capacitor CAP, CER, 220PF, 5%, 50V, 0402

49 C302,C303 Ceramic capacitor CAP, CER, 12PF, 5%, C0G, 50V, 0402

50 C300,C301, C718, C719 Ceramic capacitor CAP, CER, 10PF, 5%, C0G, 50V, 0402

51 C111,C128,C134,C146,C540,C543 Ceramic capacitor CAP, CER, 10UF, 20%, X7R, 16V, 1206

52 C500,C501 Ceramic capacitor CAP, CER, 13PF, 2%, C0G/NP0, 50V, 0603

53 C529,C530 Ceramic capacitor CAP, CER, 22UF, 20%, X5R, 16V, 0603

54 C100 TANTALUM CAP, TANT POLY, 100uF, 20%, 25V, SMD
(table continues...)
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Table 14 (continued) An example of the bill of materials (BOM) for the most important or
critical parts of the evaluation or reference board

S
No.

Reference designator Item name Description

55 C127 Ceramic capacitor CAP, CER, 120pF, 5%, C0G/NP0, 50V, 0402

56 C101, C106, C107, C110, C112, C113,
C118, C129, C131, C135, C136, C145,
C201, C202, C203, C204, C206, C209,
C211, C213, C218, C224, C225, C228,
C231, C232, C233, C234, C237, C238,
C243, C244, C245, C246, C247, C250,
C251, C252, C253, C256, C257, C258,
C260, C261, C304, C404, C406, C408,
C410, C415, C417, C419, C420, C502,
C503, C504, C505, C506, C507, C508,
C509, C511, C513, C514, C522, C523,
C524, C526, C527, C528, C534, C535,
C536, C537, C538, C539, C541, C542,
C544, C600, C601, C602, C603, C604,
C605, C701, C702, C703, C704, C705,
C707, C708, C709, C710, C712, C713,
C715, C716, C721, C722, C723, C725,
C727, C729, C730, C800, C801, C804,
C805, C806, C807, C808, C809, C810,
C812, C813, C814, C815, C816, C817,
C900, C901, C1006, C1008, C1009,
C1011, C1013, C1014, C1015, C1017,
C1018

Ceramic capacitor CAP, CER, 100nF, 10%, X7R, 50V, 0402

57 C114, C115, C137, C138, C700, C706,
C724

Ceramic capacitor CAP, CER, 10UF, 10%, 10V, X7R, 0805, SMD

58 L200, L201, L202, L203, L700, L701,
L702, L703, L704

FERRITE BEAD
INDUCTOR

IND, FERRITE, 60 OHM, 1.7A, 0402

59 L100, L102, L104 FERRITE BEAD
INDUCTOR

FERRITE, BEAD, 30 OHM, 0805, 1LN

60 L500, L501, L502, L503 FERRITE BEAD
INDUCTOR

IND, FERRITE BEAD, 600 OHM, 0805, 1LN

61 L101 Inductor IND, SHLD, 2.2uH, 20%, 9.2A, 2221

62 L103 Inductor IND, SHLD, 2.2uH, 20%, 5.5A, 1616

63 D501, D503, D700, D701, D702 TVS diode DIO, TVS ARRAY, ESD, 4CH, .45PF, 8KV, UDFN

64 D101 TVS diode DIO, TVS DIODE, 12V, 19.9V, DO214AC

65 Q100,Q101 Transistor TRANS, BIPOLAR, NPN, 30V, 0.1A, SMT,
SOT-23-3

66 D102, D103, D104, D900, D901, D902 LED LED, GREEN, CLEAR, 1206, SMD

67 D400 LED LED, 573nm, GREEN, RECT, CLEAR, 0603
(table continues...)

TRAVEO™ T2G Cluster 6M Lite Kit user guide
KIT_T2G_C-2D-6M_LITE
5  Schematic and board designs

User guide 82 002-39885 Rev. *A
2025-02-06



Table 14 (continued) An example of the bill of materials (BOM) for the most important or
critical parts of the evaluation or reference board

S
No.

Reference designator Item name Description

68 D500 LED LED, BLUE, CLEAR, 468nm, 3.3V, 0603

69 Y500 Crystal CRYSTAL, 19.2MHZ, 13PF, SMD

70 Y300 Crystal CRYSTAL, 32.7680 KHZ, 12.5PF, SMD

71 Y301 Crystal CRYSTAL, 16.0000MHZ, 10PF, SMD

72   Printed Circuit
Board

PCB, BARE, KIT_T2G_C-2D-6M_LITE

73   Fabrication
Drawing

DRW, FABRICATION DRAWING,
KIT_T2G_C-2D-6M_LITE

74   Assembly Drawing DRW, ASSEMBLY DRAWING,
KIT_T2G_C-2D-6M-LITE

75   Schematic Drawing DRW, SCHEMATIC DRAWING,
KIT_T2G_C-2D-6M_LITE

76   General Hardware HW, BUMPER, BLACK, .312" X.200",
CYLINDRICAL

77 X803, X806, X812, X813 Header HDR, CONN, HEADER, FEMALE, 2.56Mm,
8POS, GOLD, TH

78 X802 Header HDR, CONN, HEADER, FEMALE, 2.56Mm,
10POS, GOLD, TH

79 X101, X102, X403, X502, X808 Header HDR, CONN, HEADER, MALE, SINGLE,
2.54Mm, 2POS, STRAIGHT, GOLD, TH

80 X805 Header CONN, HEADER, 9POS, 2.54Mm, GOLD, T/H

81 X400, X500 Connector CONN, RCPT, USB C, TOP, MNT, HYBRID

82 X302 Connector CONN, HDR, SHROUDED, 2X10 PIN, PTH

83 X903, X908, X913, X914, X915 Connector CONN, JUMPER, SHORTING, .100", GOLD

84 X700 Connector CONN, HDMI Horizontal SMT, Female, 19
Contacts, 0.5mm Pitch

85 X701 Connector CONN, SOCKET, 0.5 FPC Conn ZIF, SMT

86 X801 Socket CONN SOCKET, Dual Angled,2.54Mm,20POS

87 S200, S400, S500, S900, S901 Tact Switch SW, TACTILE SWITCH, SPST-NO, 0.05A, 16V

88   Label LBL, PCA Label, Vendor Code, Date code,
Serial Number (YYWWVVXXXXX)

89 U400 Microcontroller IC, CYPRESS, MCU, PSOC™ 5LP, 32-bit MCU,
67 MHz, 1.8 V-5.5 V, 68-QFN

90 U200 CY_MCU IC, CYPRESS, MCU TRAVEO™ II, Cluster,
6M-216TQFP

91 U500 Miscellaneous IC, CYPRESS, FX3, 121, BGA
(table continues...)
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Table 14 (continued) An example of the bill of materials (BOM) for the most important or
critical parts of the evaluation or reference board

S
No.

Reference designator Item name Description

92 U100 Regulator,
Switching

IC, IFX, REG, BUCK, 800KHz, 2.5V-14V,
0.5V-6V, 3A, 16-QFN

93 U600 Cypress parts IC, IFX, SEMPER™ FLASH, 3.0 V, 512 Mbit, 166
MHz, FBGA 6 x 8 mm

94 U101, U103 Cypress parts IC, INFINEON, REG, LIN POS, ADJ, 500MA

5.5 Pin details
This section provides information about the primary onboard functionalities of the TRAVEO™ T2G C-2D MCU
pins on the Lite Kit and where these pins are routed, as shown in Table 15.

Table 15 MCU pin details

Pin Net RefDes

XRES XRES -

P0[0] SCB10_SDA/LIN1_TX -

P0[1] SCB10_SCL/LIN1_RX -

P0[2] BUTTON1 USER BUTTON1 (S900)

P0[3] BUTTON2 USER BUTTON2 (S901)

P0[4] SCB11_SDA -

P0[5] SCB11_SCL -

P1[0] ECI -

P1[1] ECO -

P1[4] WCI -

P1[5] WCO -

P2[3] TP300 TP300

P2[4] TRSTN X302.3

P2[5] HDMI_SYSRST R708, U700.2

P2[6] SWO_TDO X302.13

P3[0] SWCLK_TCLK R304, X302.9, U400.47

P3[1] GPIO1_2GO_1 S800.8

P3[2] SWDIO_TMS X302.7, U400.46

P3[3] SWDOE_TDI X302.5

P3[4] GPIO2_2GO_1 S800.9

P4[0] GPIO1_ARD X806.8

P4[1] GPIO2_ARD X806.7
(table continues...)
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Table 15 (continued) MCU pin details

Pin Net RefDes

P4[2] GPIO3_ARD X806.4

P4[3] GPIO1_MB X813.1

P4[4] GPIO2_MB X813.2

P4[5] LIN0_RX X802.2

P4[6] LIN0_TX X802.1

P4[7] GPIO3_2GO_1 X800.12

P5[0] CAN0_0_TX X806.5

P5[1] CAN0_0_RX X806.6

P5[2] CAN0_1_TX U800.1

P5[3] CAN0_1_RX U800.4

P5[4] CAN0_1_SLP U800.8

P5[5] GPIO4_2GO_1 S800.13

P5[6] SCB8_CLK -

P5[7] SCB8_MOSI -

P6[0] SCB8_MISO -

P6[1] SCB8_SEL0 -

P6[2] SCB8_SEL1 -

P6[3] AN1_ARD X805.1

P6[4] AN2_ARD X805.2

P6[5] AN3_ARD X805.3

P6[6] AN4_ARD X805.4

P6[7] AN1_2GO_1 S800.2

P7[0] AN2_2GO_1 S800.3

P7[1] AN1_2GO_2 S801.2

P7[2] AN2_2GO_2 S801.3

P7[3] AN1_MB X812.1

P7[4] POT POT (R904)

P7[5] LED1 LED1 (D900)

P7[6] LED2 LED2 (D901)

P7[7] LED3 LED3 (D902)

P8[0] GPIO1_2GO_2 S801.8

P8[1] GPIO2_2GO_2 S801.9

P8[2] GPIO3_2GO_2 S801.12
(table continues...)
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Table 15 (continued) MCU pin details

Pin Net RefDes

P8[3] GPIO4_2GO_2 S801.13

P9[0] SCB7_RX -

P9[1] SCB7_TX -

P9[2] RPI_GPIO1 X800.7

P9[3] RPI_GPIO2 X800.11

P9[4] RPI_GPIO3 X800.13

P9[5] RPI_GPIO4 X800.15

P9[6] RPI_GPIO5 X800.29

P9[7] RPI_GPIO6 X800.31

P11[0] SCB0_MISO -

P11[1] SCB0_SEL0 -

P11[2] SCB0_CLK -

P11[3] SCB0_MOSI -

P11[4] RPI_GPIO7 X800.36

P11[5] TDM_TX_SCK3 U700.13

P11[6] TDM_TX_FSYNC3 U700.12

P11[7] TDM_TX_SD3 U700.9

P12[0] SCB0_SEL3 -

P12[1] P12.1 -

P12[2] NC -

P12[3] MIPI_PE X701.17

P12[4] MIPI_LE X701.18

P12[5] ETH_INT_N U1000.31

P12[6] P12.6 -

P12[7] NC -

P13[0] ETH_MDC U1000.13

P13[1] ETH_MDIO U1000.14

P13[2] ETH_TXD_0 U1000.18

P13[3] ETH_TXD_1 U1000.17

P13[4] ETH_TXD_CLK U1000.20

P13[5] ETH_REF_CLK U1000.35

P13[6] ETH_TXD_2 U1000.16

P13[7] ETH_TXD_3 U1000.15
(table continues...)
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Table 15 (continued) MCU pin details

Pin Net RefDes

P14[0] ETH_TX_CTL U1000.19

P14[1] TP303 TP303

P14[2] ETH_RX_CLK U1000.27

P14[3] ETH_RXD_0 U1000.25

P14[4] ETH_RXD_1 U1000.24

P14[5] ETH_RXD_2 U1000.23

P14[6] ETH_RXD_3 U1000.22

P14[7] ETH_RX_CTL U1000.26

P15[2] SCB1_SDA -

P15[3] SCB1_SCL -

P15[4] RGB_GPIO2 -

P15[5] RPI_GPIO8/P15.5 X800.32

P15[6] TDM_TX_MCK0 X800.18

P15[7] TDM_TX_SCK0 X800.12

P16[0] TDM_TX_FSYNC0 X800.35

P16[1] TDM_TX_SD0 X800.40

P16[2] TDM_RX_MCK0 -

P16[3] TDM_RX_SCK0 -

P16[4] TDM_RX_FSYNC0 -

P16[5] TDM_RX_SD0 X800.38

P16[6] RPI_GPIO9/P16.6 X800.22

P16[7] RGB_RED0 -

P17[0] RGB_RED1 -

P18[0] RGB_RED2 -

P18[1] RGB_RED3 -

P18[2] RGB_RED4 -

P18[3] RGB_RED5 -

P18[4] RGB_RED6 -

P18[5] RGB_RED7 -

P18[6] RGB_GREEN0 -

P18[7] RGB_GREEN1 -

P19[0] RGB_GREEN2 -

P19[1] RGB_GREEN3 -
(table continues...)
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Table 15 (continued) MCU pin details

Pin Net RefDes

P19[2] RGB_GREEN4 -

P19[3] RGB_GREEN5 -

P19[4] RGB_GREEN6 -

P19[5] RGB_GREEN7 -

P19[6] RGB_BLUE0 -

P19[7] RGB_BLUE1 -

P20[0] RGB_BLUE2 -

P20[1] RGB_BLUE3 -

P20[2] RGB_BLUE4 -

P20[3] RGB_BLUE5 -

P20[4] RGB_BLUE6 -

P20[5] RGB_BLUE7 -

P20[6] RGB_LVALID -

P20[7] RGB_VSYNC -

P21[0] RGB_DE -

P21[1] RGB_CLK -

P21[2] RGB_GPIO0 -

P21[3] RGB_GPIO1 -

P23[0] SPIHB0_DATA4 U600.D5

P23[1] SPIHB0_DATA2 U600.C4

P23[2] SPIHB0_DATA3 U600.D4

P23[3] SPIHB0_DATA5 U600.E3

P23[4] SPIHB0_RWDS U600.C3

P24[0] SPIHB0_CLK_N U600.B1

P24[1] SPIHB0_CLK_P U600.B2

P25[0] SPIHB0_DATA0 U600.D3

P25[1] SPIHB0_DATA6 U600.E2

P25[2] SPIHB0_SEL0 U600.C2

P25[3] SPIHB0_DATA1 U600.D2

P25[4] SPIHB0_DATA7 U600.E1

P25[5] SPIHB0_SEL1 U600.A3

P26[0] SPIHB1_DATA4 U601.D5

P26[1] SPIHB1_DATA2 U601.C4
(table continues...)
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Table 15 (continued) MCU pin details

Pin Net RefDes

P26[2] SPIHB1_DATA3 U601.D4

P26[3] SPIHB1_DATA5 U601.E3

P26[4] SPIHB1_RWDS U601.C3

P27[0] SPIHB1_CLK_N U601.B1

P27[1] SPIHB1_CLK_P U601.B2

P28[0] SPIHB1_DATA0 U601.D3

P28[1] SPIHB1_DATA6 U601.E2

P28[2] SPIHB1_SEL0 U601.C2

P28[3] SPIHB1_DATA1 U601.D2

P28[4] SPIHB1_DATA7 U601.E1

P28[5] SPIHB1_SEL1 U601.A3

P29[0] SCB9_RX -

P29[1] SCB9_TX -

P30[0] TP304 TP304

P30[1] TP305 TP305
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Glossary
Abbreviation Definition
AC Alternating current

ADC Analog-to-digital converter

BOM Bill of materials

CAN Controller area network

CAP Capacitor

CAN FD Controller area network flexible data-rate

CPU Central processing unit

DAC Digital-to-analog converter

DC Direct current

ECO External crystal oscillator

ESD Electrostatic discharge

ETH Ethernet

GPIO General-purpose input output

HFLASH Hyper-Flash

HRAM Hyper random-access memory

IC Integrated circuit

IDE Integrated development environment

IoT Internet of things

I2C Inter-integrated circuit

I2S Inter-IC sound

LED Light-emitting diode

LIN Local interconnect network

LDO Ow dropout voltage regulator

LPO Low power oscillator

MCU Microcontroller unit

PC Personal computer

POT Potentiometer

PMIC Power management integrated circuits

QSPI Quad serial peripheral interface

SCB Serial communication block

SDK Software development kit

SMIF Serial memory interface

SPI Serial peripheral interface

SRAM Static random-access memory

SWD Serial wire debug

TP Test point

UART Universal asynchronous receiver transmitter
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Abbreviation Definition
USB Universal serial bus

WCO Watch crystal oscillator
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References
This section has some links for datasheet and documents, you can visit and find resources as per needs.
1. TRAVEO™ T2G Cluster 6M Lite Kit
2. TRAVEO™ T2G CYT4DN
3. TRAVEO™ T2G CYT4DN Datasheet
4. EZ-USB™ FX3
5. EZ-USB™ FX3 Getting Started
6. EZ-USB™ FX3 SDK
7. PSOC™ 5LP
8. PSOC™ 5LP Datasheet
9. KitProg3 User Guide
10. SEMPER™ Flash Datasheet
11. HYPERRAM™ ( S27KS ) Datasheet
12. IR3883 PMIC
13. IR3883 PMIC Datasheet
14. TLS205B0 LDO Datasheet
15. TPS62A02DRLR PMIC Datasheet
16. CY8CKIT-026 CAN and LIN Shield
17. CY8CKIT-026 CAN and LIN Shield Schematic
18. WM8960 Audio HAT
19. WM8960 Audio HAT Schematic
20. WM8960 Audio HAT Datasheet

Note: For any questions regarding peripheral blocks or code examples, visit the Infineon Developer
Community website for solutions.
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